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Part I. Basic Team Competitions

Step 1: Insert Team Assignment and Team Leader slides
1. Open TurningPoint

2. Click on the TurningPoint ribbon

your presentation
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Fig 1: Team Assignment Slide

Students select the number on their

clicker corresponding to their team.

N

4. The slide will by default, show five teams. If you wish, you can give each team a name.

To add a team, hit return after Team 5. To delete a team, select it and hit delete on your

Please select a Team.
1. |Bull Dogs 25%  25%  25%  25%
2. |Terriers

3. |Rottweilers

4. |Chihuahuas
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3. Click on Insert Slide and select Team Assignment Slide — place it at the beginning of
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5. After you add your TurningPoint question slides, go to the TurningPoint Ribbon and click

on the Insert Slide menu. Select either Team Leader Board or Racing Leader
Boards. Do not add data or text to these slides.

Team Scores

0 Team 1
0 Team 2
0 Team 3
0 Team 4
0 Team 5

Team Assignment Slide

Participant Leader Board

Cal S

Team Leader Board

MYF  Team MVP

B

Fastest Responders

Racing Leader Boards

)

Fig 2: Team Leader Slide

Racing Leader Board

Fig 3: Racing Leader Slide

Note: The Team Leader slide displays the number of points each team has scored from highest to
lowest. The Racing Board Slide (available in TurningPoint 2008 version 4.2 and higher) indicates the
team scores with a horse race graphic or balloon graphic. You can insert these slides periodically

¢

throughout your presentation to generate a competitive spirit or select them during your presentation at
any time. They are automatically updated after responses for each question are collected.
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Step 2: Play your Presentation

1. Assign students to teams. When you are ready to begin your presentation, go to the
Slide Show ribbon and click From Beginning to play your slide show. The team
assignment slide should be at the beginning of your presentation.

2. When the polling bar located at the top right of your screen displays “polling open,” have
your students select their team by pressing the appropriate number on their
response cards (all teams will be numbered on the team assignment slide — see
fig. 1 on page 1).

userfeedback: polling:

8O 0B 5-00-= @ @O [ : i

3. Close polling and continue with your presentation.

4. When a Team Leader or Racing Board slide appears (see fig. 2), you will see the total
scores of each team at that point in the presentation.

Note: In TurningPoint 2007 version 4.1 and above, you can set the point
value for each question by selecting a TurningPoint slide and typing a value
in the “Correct” field under Default Point Values in the task pane (right
sidebar).

Defaulk Point Walues
|1
IIZI

Carreck:

Incorrect:

In earlier versions of TurningPoint, set point values by going to the TurningPoint Ribbon and clicking
on Tools > Settings. Select the Settings tab, and then select the question in the slide hierarchy. In the
pane at right, go to Misc section and click on the Correct Point Value. Enter a numerical value in the

box provided.
3 & TurningPoint - Settings

| Settings |Po||ingTest|

- Response Device

|»

-2 "Whenever I eat dairy product:
--3 "Lately I have been short of br
-4 ™1 am a smoker but lately I ca
=14 Answer Options

-1 Assign the patient to a private
-2 Assi Iy o egiver tg th

Question Alias
Response Data
Responses

Speed Scoring
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-10 Answer Choices
~1 Call the MD immediately for ar | Allow Duplicates False
--2 Assess the pts. Level of consci Anonymous False
--3 Replace the machine and prob |Correct Point Value
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Part Il Participant Lists and Advanced Competitions

Participant lists allow you to record and export scores for individual
students and to use competition slides for that show individual top

student scores.

Step 1: Insert Participant Slides:

1. After you have created your TP slides, go to the
TurningPoint ribbon and click on the Insert Slide drop

down menu.

2. Select Participant Leader Board, Team MVP, Fastest
Responders, or Wager Slide.

3. Do not add text or data to the slides.

Note: All of the above slides give feedback on individual students’
scores during the presentation. The wager slide allows students to
wager some or all of their accumulated points on a question. You can
insert these slides periodically throughout your presentation to

generate a competitive spirit.

Step 2: Create a participant list

e

® o

Vertical Slide

Horizontal Slide

3D Pie Slide
Distributed Pie Slide
Offset Slide
Doughnut Slide
Responses Only

Team Assignment Slide

Participant Leader Board ]

| B Bl
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=
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B
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ﬂ_
| e

Wager Slide
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4. In the TurningPoint ribbon, click the Participants
drop down menu and select Participant List
Wizard.

'—_.. TurningPoint - Participant List Wizard

O

Please select a Participant List Template

" Education Template

e [ernplalte 1-149-

— - -
> )
ga |© X
Participants | Import TurningTalk Help

Display Participant Monitar

[Ed Participant List Wizard
Import a Participant List %
Edit a Participant List

Delete a Participant List

Real-Time Registration Tool

Participant List Display

@ Mew Template 1-26-2011 Mo IDs
@ Mew Template 2-4-2011 S-10PM
@ Mew Template 2-7-Z011 10-19 Al
@ Reena Test

" Corporate Template

" Awailable Fields Template

% Custom Template

Delete

A

5. Inthe TurningPoint
Participant Wizard window,
select Custom Template
and make sure (Create a
new template) under My
Custom Templates is
selected.

Bark

Cancel |

ook |
e ]

6. Click Next.
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7.

10.

In window that appears, give
your template a name and click
OK.

In the Participant List Fields
window, select the fields that
you would like to include in
your participant list. Click on
the field title in the left column
then move it to the right
column by clicking on the
right-facing arrow. To delete a
field, select it in the right
column and click on the left
facing arrow. Generally you
will only need first name and
last name fields.

When you are finished adding
fields, click Next.

Samuel Merritt University

| g TurningPoint

Flease enter a name for yaur custorn template.

INursing 101 Template - Spring 2011

I

g TurningPoint - Participant List Wizard

Please select your participant list fields

Available Fields Selected Fields

Firsk Name

the selected Field{s) [alk + Ri

Add a custom fisld

Cancel |

Back.

Tk

In the Add Groups window
(optional), type the name of
each group to which you
would like to assign
students and click Add. The
groups will show up in the
Included Groups column.
Select the check box for
each group you would
like to include in your
participant list and click
Next.

Note: you can also assign
groups with the Team

g TurningPoint - Participant List Wizard

Add Groups to your Participant List

You may optionally include Groups within your Included Groups

Participant List, Participants may be assigned
to these groups for purposes of tracking
dermographics andfor teamn cormpetition,

Add |I

Group 1
Group 2
Group 3
Group 4

Create a new group
Group 5

Check the groups that you wish to be included in
tearn competition.

Cancel |

Remove |

Assignment slide (see

above).
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11. In the Add Participant
Information window,
give your participant list
a name and click
Finish.

g TurningPoint - Participant List Wizard

Participant Lisk Surmmary

Add Participant Information

Samuel Merritt University

Marne: INursing 101 2-7-201
Mumber of Fields: z

Mumber of Groups: 4

Cancel |

Click "Finish" to generate your Participant List and launch the Participant
Information Dialog, From this dialog you can add, edit, import, or export
participant information and assign participants to groups,

Back | Finish |

12. In the Participant Information window, type or paste the names of the students into the
grid. To add a row, go to Edit > Add Participant. To move columns, click on the check

box at the bottom of the window, select a column, and drag it.

Participant Information - Mursing 101 2-73

g Participant Information - Nursing 101 2-7-201.tpl

© File  Edit  Import

Device 1D First Mame

Last MName

Lady

3aga

Erittany

Spears

Paris

Hiltan

|| e

Courkney

Love

Group 1 | Group 2 | Group S | Group ¢

L—
[ Chedk to rearrange column order (editing Functionalicy will be limited)

Edit | Import

Cuk Chrl+2

Copy Chrl+iC
Paste Chel+y

Select Al Chrl4-4,

Cleat Dl

Add Participant

Remove Participantis)

Add Field/Group 3
Remove Field/Group

Rename Field/Group

"L LAl e, gt -,

Please select a Participant List wou would like to edit by clicking the File menu and click Open

Cancel | ! Done ! I

13. Select a group for each student by clicking on the correct checkbox. Click Done.
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Note: you can also export a roster of first and last names from your Blackboard grade book or create
one in Excel. The file should be saved as a tab delimited text file. Move the Device ID column to the
third column position in the grid, then either import the text file by going to Import > Excel delimited
text file, or select all cells in your Excel document, copy them, and paste them into the Participant
information grid.

Step 3: Use Real Time Registration to register clickers (optional — versions 4.2
and up only)

| TurningPoint 2008 * X
1. Open your presentation

’*SEssion Options

] & e |

Participant List ————————
|: ftuita] |

[&uta) -l
Mew List 1-13-2017 4-43-22 P
Mew List 1-26-2017 4-12-45 P

Mew List 1-26-2011 5-08-17 P
Mew List 2-4-2011 5-03-45 PM

2. Select the TurningPoint Ribbon

3. Go to the task pane (the right sidebar)

4. In the Participant List drop-down menu, select the
Participant List you just made.

Participants|Import TurningTalk Help 5

eal lime [eg

In the

|| B Display Participant Monitor TurningPOint ribbona
[Ed Participant List Wizard click on Participants
&) Import a Participant List and select Real Time Registration Tool.
g Edit a Participant List
8 Delete a Participant List 6. The Real Time Registration window will open (below)
&% Real-Time Registration Tool and the names of your students will appear in a grid.
[E Participant List Display
1 P ¥ 2 TurningPoint - Real-Time Registration Tool Ol =
PP — |
© Registration Closed
Name Device ID
7. Click on the 1 |tedyGaga
Registration 2 |Brittany Spears
Closed 3 | Paris Hilton
button at the 4 |Courtney Love
top left of the 5
window to 6
begin 7
registration. g
9
0

“«r»
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8. On their clickers, have each student select the number next their name. If you have
more than 10 students, allow each student on the first page to respond then move to the

9.

10.

Notes on Participant Lists:

@)

aa @ <

Participants| Import TurningTalk H

-

second page using the forward arrow, and so on.

When all students have registered their clickers, click Registration Open
to end the registration process. Close the registration window.

) FRegistration Open

Play your presentation as usual. The participant slides will give feedback regarding
individual scores and leaders.

Viewing Participant Lists:

If you would like to see which students are entered on a participant list, go to the
TurningPoint ribbon, click on the Participants drop down menu and select Participant

List Display.

Deleting Participant Lists:

Go to the TurningPoint ribbon, click on the Participants drop down menu and select
Delete a Participant List. Choose the list you would like to delete and click Delete.

Editing Participant Lists:

In the TurningPoint ribbon, click on the Participants drop down menu and select Edit
Participant List. Select the list you would like to edit in the dialog box and click Open. In

the participant grid that opens, you can click on any cell to edit it.

P

=] "

Display Participant Monitor
Participant List Wizard
Import a Participant List

Edit a Participant List

Edit  Import
Device 1D Last Marme Fitst Mame Blackboard User 1D
1FO8z3 Lisa lisasimpson
1F0955 Gaga Lady lgaga
1FO94D Mirren Helen himirren

Delete a Farticipant List

Real-Time Registration Tool

Participant List Display
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Part Ill: Generating Reports and Grades

Step 1: Choose your Participant List and Run your TurningPoint 2008 v X
Presentation Session Options 1
(ﬂﬂ E> I

1. Click on the TurningPoint ribbon and go to the task pane
(the right sidebar).

—Participant Lisk
I I temp-fullman_practice_course B-j I‘

2. Under Participant List, make sure you have the correct
list selected in the pull-down menu.

Incorrect: I i] |

3. Select each TP slide and make sure you have assigned
points for the correct answers under Default Point Value
and have indicated a correct answer under Answer
Values.

Clear All Anzwer Walues |

[ Answer Walues

1 ICnrreu:t vl

4. Run your slide show by going to the Slideshow ribbon and ¢ [Incorrect -]
clicking From Beginning. €

Home 4

Default Point Values —|'
’if:nrrect: |25 Ii

Incomect

| j"
IIncorrect - I

Step 2: Generate Report I=I ,
e MR e A apEme. A amtn
1. Inthe TurningPoint ribbon, click Save Session. sf‘f:{zn

2. Inthe Save Session 21
WindF)W, give your Save in; IE}Sessions j o FCE
Session a name or ~
Backup
use the def,aUIt Mew Session 1-26-2011 5-30 PM.tpz
name. Navigate to a Mews Session 1-26-2011 7-26 PM tpz

folder you would like
to save in or use the
default location.

Meww Session 3-18-2011 3-04 PM.tpz
MNews Session 3-18-2011 3-28 PM.tpz
Mew Session 3-15-2011 3-44 PM.tpz

Meww Session 3-18-2011 10-23 AM.tpz

MNews Session 3-21-2011 2-15 PM.tpz

Mew Session 3-21-2011 2-36 PM.tpz

Meww Session 3-21-2011 3-19 PM.tpz

Mews Session 3-22-2011 4-59 PM.tpz

Mew Session 11-23-2010 11-05 AM.tpz
Test_Partlist Session 3-17-2011 6-26 PM.tpz

3. Click Save.

1 I Diocu

"

by Conputer

File name: H e 5

2011 722 M =l Save
- Cancel
)

Save as type: ITumingPoint Session [*.tpz]

Note: The default name includes your course name and the date. The default save location
is C:\Documents and Settings\username\My Documents\ TurningPoint\Participants.
You can save your participant list in another location if you wish. If you plan to save your

10
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presentation on a Flash drive, save your participant list there as well. Keep Save as type set
to the default — (*.tpl,*tpp)

. . . . 1 Response Devices 3
In the TurningPoint ribbon, click on the Tools drop-
down menu and select Reports. Tools
. . . Reports
In the Reports window, click on the Sessions tab = B H
Session Management ¥

and select the session you would like to run a report
on. Current Session generates a report for the
session you currently have open in TurningPoint.

# Standards

¥ g Reports - New Session 3-23-2011 7-22 PM o ]| ﬁ

Sessions Eeports |

Please select your session
ﬁ r@? Press F5 to refresh the sessions lisk
Mame | Date
8 Current Session 312312011
B hew Session 1-26-2011 5-30 PM 1/26/2011 5:30:49 PM ]
8 New Session 1-26-2011 7-26 PM 1j26/2011 7:26:39 PM '
B hew Session 11-23-2010 11-05 AM 11/23j2010 11:05:50 AM
8 New Session 3-18-2011 10-23 &M 3/18/2011 10:23:28 AM
B hew Session 3-13-2011 3-04 PM 3/18/2011 3:04:20 PM b
8 New Session 3-18-2011 3-26 PM 3/18/2011 3:28:11 PM
B hew Session 3-13-2011 3-44 PM 3/18/2011 3:44:53 PM
8 New Session 3-21-2011 2-15 PM 3/21j2011 2:15:29 PM
B hew Session 3-21-2011 2-36 PM 3/21j2011 2:36:43 PM
8 New Session 3-21-2011 3-19 PM 3/21j2011 3:19:36 PM ;
3f22j2011 5:00:02 PM
o J

Note: You can import a session file from another location (the list only shows session files stored in
the default location). Click the folder icon above the list of files to import a session.

6.

7.

8.

Click on the Reports tab (see next page).

Select the type of report(s) you would like to generate by selecting the check box next to
the report name. You can select multiple reports by selecting multiple check boxes. You
can also select an entire category of reports by selecting the check box for the category.

The two most common report categories are Results by Question and Participant
Results. For more information on report types, see page 225 in the TurningPoint
manual.
o Results by Question (see fig. 4 on page 13): This category is useful for
assessing the effectiveness of your questions and quickly determining areas or
topics that may need further review. It is useful for planning future activities,

11
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lectures, test reviews, readings, etc. Each report is generated in a separate excel
worksheet

o Participant Results (see fig. 5 on page 13): This category provides scores for
each participant. Each report displays scores using different parameters (note:
you must use a participant list to generate a participant result report) :

o Graded Participant Results (Correct/Incorrect) displays the score for each
student as a percentage

o Graded Participant Results (Point Values) displays the score for each
student as points

o Graded Participant Results (Ratio) displays the score for each student as
a ratio of correct to incorrect answers

o Participant Results displays the numerical responses that each participant
submitted.

¥ gReports - New Session 3-23-2011 7-22 PM o ] 4|

e

Sessions  Reparts |

Please select the report(s) to generate

Reports by Category

EIB'P Results by Question Repaorts 1= m
-—?] Graphical Resulks by Question uil i e i R R B e i e e
------ @ Resulks by Question
B Demographic Reports
=l wW= Particpan 7 KEDOFER i
@ Graded Participant Results (Correct/Incorrect -
E’l Graded Participant Results (Point Yalues) i
E’] Graded Participant Results (Ratio)

E]
1
]
[}
i

- [FRE] Participant Results ,

Emu RESUILS U Farulipanic R EUUrL. 1l -jl
- - ) = L

& Dﬁp Participant Lists e L el G B by e Emmeha by peeecen vt i § e B e |4 [
- Standards Reports —
H-Og& Comparative Scaring Reparts Ceeiplian ansFisper: Sams
_.I .—.E; - R . | _ILI Report Description
4 *

Cateqories in italics have options

[ Change numeric respanses to alphabetic responses (1 = &, 2 = B, etc)

Exit Generate Report

9. Click Generate Report. Turning Reports generates the report(s) and opens it in
Microsoft Excel or Word, whichever is appropriate. This may take some time, especially
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if you opted to generate a large number of reports or if there are numerous questions or
participants in the session. You can generate as many reports as you like.

Note: Alternatively, you can generate a report by double clicking on the report name. Only
that report will be generated.

10. When you are finished creating reports, select the Exit button to close the Turning
Reports window.

11. You can use Excel or Word to edit, save, or print the reports. You can also copy and
paste scores into your Blackboard grade book. To learn how to automate this
process by fully integrating Blackboard and TurningPoint, see the TurningPoint:
Blackboard Integration guide.

A B C D E F G H 1 ] K L M N a
Turning Graphical Results by Question

Session Name: Current Session
Created: 3/23/2011 8:24 PM

2.) What famous document begins: "When in the course

33.3% 0% 33.3%
of human events..."? (multiple choice) Responses
The Declaration of Independence. 1 33.33%
The Bill of Rights 1 33.35%

- B 33.3%
The Communist Manifesto 1 33.33%
MLK's “I Have & Dream” speech 0 0% ¥ The Declaration of Independence.
Totals 3 100%  The Bill of Rights
The Communist Manifesta
B MLK's “| Have a Dream” speech
J

Fig. 4: Report: Graphical Results by Questions
Correct answer is indicated in green. Because only 33% of students submitted the correct answer to this
question, you may consider further lecture or review on this topic.

A B C D E F G H 1 ]
Turning Graded Participant Results

Session Name: Current Session
Created: 3/23/2011 8:24 PM

Device ID Last Name First Name Blackboard User ID 1) Who is the curr 2) What famous doc 3) What 20th-cet 4) Who is consl Total Points
1F0AZ3 Simpson Lisa lisasimpson 3i 1c 1i 3i '25
1FD955 Gaga Lady lgaga 1c 2i 1i 1c S0
1F094D Mirren Helen hmirren 1c 3i 3c 1c 75

Fig. 5: Report: Graded Participant Results (Point Values)
This report shows the each students score as a point value.
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